
 

Frequently Asked Questions 

 
Micro Filter 

 
Installation, configuration, setup 

 

Question 

I just installed the new version of the Micro Filter for Windows (non-TCP/IP version) and now 

when I run a report in URSA, I get the message "DARGAL MICRO CODE NOT FOUND." I am 

using INFOConnect as my transport. What could be wrong?  

Resolution 

Make sure that you have installed the new version of the Micro Filter for Windows in the 

correct location. The default location for the original Micro Filter for Windows (non-TCP/IP 

version) is C:\URSA. In this case, the Micro Filter needed to be installed in the INFOConnect 
folder.  

 

Question 

I just copied all the Micro Filter files to my new PC and now I get "DARGAL MICRO CODE NOT 

FOUND" when I try to run a report in EZSPEC. I use the Micro Filter for Windows with 

INFOConnect as my transport. What could be happening?  

Resolution 

Determine that all the Micro Filter files and transport files are in the same locations as on the 

old PC. In this case, the user was now running the 32-bit version of INFOConnect instead of 

the 16-bit version. He was still trying to use the 16-bit version of the Micro Filter for Windows. 

The solution in this case was to install the 32-bit version of the Micro Filter for Windows and 

use it in conjunction with the 32-bit version of INFOConnect. See Version compatibility for 

more information about mixing 16-bit and 32-bit versions of emulators/transports, the Micro 
Filter for Windows, and URSA.  

 

Question 

I'm trying to bring micro output into Word 2000. There seems to be a conflict. Is there a 

special option I need to set?  

Resolution 



 
If you are using Microsoft Word 2000, you need to change the security setting for macros to 

Medium in Word. The default setting is High, which does not allow you to enable DDE macros 

automatically. In Word 2000, choose Tools menu > Macro command > Security option > 

Security Level tab > Medium setting to reset the security level so you can use DDE.  

 

Question 

I just downloaded the Micro Filter for Windows from your FTP site. When I'm in the process of 

running the setup program, I get the message "FILE NOT FOUND." What's wrong?  

Resolution 

The Micro Filter software is contained in two zip files. Make sure that you unzip both files in 

the same folder. If you unzip just the first file, you'll get the "FILE NOT FOUND" message while 
running the setup program.  

 

Question 

I just installed the Micro Filter for Windows and I'm using INFOConnect as my transport. I get 

the message "DARGAL MICRO CODE NOT FOUND" when I try to run a report in EZSPEC. What 

could be wrong?  

Resolution 

When you use the Micro Filter in conjunction with INFOConnect, you need to complete the 

installation in INFOConnect. Part of the process involves setting up an INFOConnect path 

between the PC and the host. The path consists of a path template and all the other 

information needed for the PC to communicate with the host. You need to make sure that the 

path is properly configured.  

 

Question 

I just got around to installing copies of the Micro Filter for TCP/IP and URSA that I've had for a 

few months. When I try to run a report, I get the message "CONNECTION FAILED TO 

MICROFILTER FOR TCP/IP." What should I do?  

Resolution 

This message usually indicates that the Micro Filter cannot locate your IP address. You should 

download the latest versions of URSA and the Micro Filter for TCP/IP from our ftp site, 

ftp://ftp.dsinc.com. We will send you the latest version of DARGAL, too. In URSA Version 



 
3.00.236, we updated the the Preferences dialog box to include some options relating to the 

Micro Filter for TCP/IP. You can specify whether to send your computer’s IP address or the IP 

address of another computer to the host program. The version on our ftp site is even more 

current than that.  

Note: Changing the IP address for the Micro Filter for TCP/IP interactively using the 

Preferences dialog box requires DARGAL Version 59.130 or higher. The version we are 
currently shipping is higher than that.  

 

Question 

I installed the Micro Filter for TCP/IP a couple of months ago and it's working fine. Now, I want 

to add DDE support for Excel 97. How do I do this?  

Resolution 

1. Insert the Decision Support Inc. software CD into your CD-ROM drive and run the 

setup program for the Micro Filter for TCP/IP. 

 

(If you have installation diskettes, use those instead.) 

2. In the Select Options dialog box, remove the check mark from beside Install Micro 
Filter and place one beside Set up DDE Application(s).  

3. Choose Microsoft Excel 97 in the DDE Applications dialog box.  
4. In the DDE Associations dialog box, associate the extension XLS with the application 

Microsoft Excel 97.  

5. In the DDE Path Names dialog box, select the application (Microsoft Excel 97) and 

set a path name.  

Your DDE setup is complete. See "Setting up DDE" in chapter 1 of the Micro Filter for Windows 

Installation Guide if you need more detailed information.  

 

Question 

While trying to install the DDE portion of the Micro Filter, I get an error message about the 

DDE setup failing when I choose the Continue button. Any ideas about what might be causing 

this?  

Resolution 

It is possible that you do not have access to the directories in which you are trying to place 

the macros. Or, maybe there is some sort of security in place at your site that prevents you 

from installing macros. When you set up DDE with the Micro Filter, the Micro Filter tries to 

copy macro files such as dmf.xla (for Excel) and dmf.dot (for Word) to your working 



 
directories for those products. In this case, the user copied the macro files manually to the 
appropriate directories and then everything worked as expected.  

 

Question 

Can I install the Micro Filter for TCP/IP on a LAN, and then have all users access it from there?  

Resolution 

You can load the Micro Filter for TCP/IP installation program on a LAN, and have users run 

setup.exe from there. However, the Micro Filter for TCP/IP itself must be installed on the PC of 
each user who needs to use it.  

 
Functionality-related 

 

Question 

Is there a rule for mixing 16-bit and 32-bit versions of emulators/transports, the Micro Filter 

for Windows, and URSA?  

Resolution 

To be safe, you should use either all 32-bit versions or all 16-bit versions. If possible, use the 

32-bit versions. 

 

If you're having trouble loading the Micro Filter for Windows with a particular emulator, you 

may want to try the Micro Filter for TCP/IP. The Micro Filter for TCP/IP communicates with the 

host through a direct TCP/IP connection between the PC and the host. If you have the 

appropriate hardware and the appropriate software installed on your PC and the host, you can 
use the Micro Filter for TCP/IP with any emulator — regardless of the transport it uses.  

 

Question 

Do we need to license the Micro Filter for Windows for each PC on which we want to install it?  

Resolution 

No. With a single license, you can install the Micro Filter for Windows on any PC within your 
organization.  



 

 

Question 

Are the Micro Filter for TCP/IP and the Micro Filter for Windows part of the same product?  

Resolution 

There are two variations of the Micro Filter for Windows — the original Micro Filter for Windows 

and the Micro Filter for TCP/IP. Furthermore, each is available in a 16-bit and 32-bit format. 

Each version has the same functionality. (The 16-bit version is not shipped automatically. If 
you want to use this version, you must request it.)  

The original Micro Filter for Windows works with INFOConnect or any terminal emulator that 

uses its own native transport and conforms to the interface specification supplied by Decision 

Support Inc. To be supported by the original Micro Filter for Windows, the terminal emulator 

must be able to inform the Micro Filter of any messages it receives and send any messages 

that the Micro Filter wants to transmit. The Micro Filter for Windows is not compatible with 

terminal emulators that do not meet these requirements.  

The Micro Filter for TCP/IP communicates with the host through a direct TCP/IP connection 

between the PC and the host. If you have the appropriate hardware and the appropriate 

software installed on your PC and the host, you can use the Micro Filter for TCP/IP with any 

emulator — regardless of the transport it uses. See the Micro Filter for Windows Installation 
Guide for more information.  

 

Question 

Is there any type of log file that lets me track messages when I'm having problems with the 

Micro Filter?  

Resolution 

The Debug File command in the Options menu in the Micro Filter window lets you specify 

whether datacomm messages are written to a file in the directory where Windows is installed 

or another directory. The file is called DEBUG._ME. The file is created if it does not already 
exist. Otherwise, all data received by or transmitted from the Micro Filter for Windows is 
appended to the file.  

Follow these steps to use the debug option:  

1. Choose Options in the Micro Filter window.  

2. Select Debug File to access the dialog box that allows you to specify whether 

datacomm messages are written to the debug file. 

 

The Debug File dialog box appears. 



 
3. Select Enable Debug File. 

 

When you select Enable Debug File, the File name option becomes available. You 

can specify a different file name or directory if you like. 

4. Remove the check mark beside Enable Debug File when you finish using it during a 

session. Otherwise, data will continue to be appended to the file. (The option is 

automatically disabled at the end of a session.) 

5. Delete the file DEBUG._ME when you no longer have any use for it. (If you do not 

delete the file, new messages will be appended to the old messages the next time you 
select Enable Debug File.) 

 

Browse window related 
 

Question 

Is there a way for me to copy information from a Browse window into another application? I've 

tried highlighting the text and then using the right mouse button, but it doesn't seem to work.  

Resolution 

You can use the Copy command (Edit menu) in the Browse window to copy selected text from 

the Browse window to the Windows clipboard. Then switch to another application in another 
window and paste the contents of the clipboard into that application. Follow these steps:  

1. Select the text you want to copy with the mouse.  

2. Choose Edit from the Browse menu bar.  

3. Choose Copy. The highlighted text is copied to the Windows clipboard.  

4. Switch to another application in another window and paste the contents of the 
clipboard into that application.  

 

Question 

I've sent DARGAL report output to Browse many times. Are there any other commands that 

can use Browse as an output device?  

Resolution 

Browse is one of the standard output options. You can use Browse with the following DARGAL 

commands: DCat, DIF, Dir, DList, FIND, Help, List, SCRibe, SHow, WHAT, and Write. 

 

You can also use Browse with the following File Description Subsystem instructions: FIND, 



 
Help, List, and SHow. 

 
Browse is the default output device for URSA and it is one of the devices available in EZSPEC.  

 

Question 

I know that I can split my Browse window, but how do I do it?  

Resolution 

In the Browse window, choose Split Vertical or Split Horizontal from the View menu. The 

Split Vertical command splits the Browse window into left and right panes. When you scroll 

up or down in either pane, the data in both panes moves. When you scroll horizontally, the 

data in the active pane moves. To resize the panes, click on the split bar and drag it where 

you want it. Use your mouse or the F6 key to move from one pane to the other. The Split 
Horizontal command splits the Browse window into top and bottom panes. When you scroll 

left or right in either pane, the data in both panes moves. When you scroll vertically, the data 

in the active pane moves. To resize the panes, click on the split bar and drag it where you 

want it. You can use your mouse or the F6 key to move from one pane to the other. Use the 
Remove Split command to restore the Browse window to a single window.  

 

Question 

Can I change the color of the text that appears in a Browse window?  

Resolution 

Three commands available in the Options menu of the Browse window allow you to control 

the colors that appear in your Browse window. They are: Text Color, Heading Color, 
Background Color.  

If you choose any of these commands, the Color dialog box appears. Select a color by clicking 

on one of the 48 colors in the Basic colors palette. With Windows, text can be drawn in solid 
colors — colors in which all pixels are the same color, not a combination of colors.  

If you choose a nonsolid color for Text Color or Heading Color, text will be drawn in the 

solid color closest to the chosen color. If you choose a nonsolid color for Background Color, 
the area surrounding text and headings will be drawn in the solid color closest to the chosen 
color.  

 
 

 



 

TCP/IP related 
 

Question 

What do I need to run the Micro Filter for TCP/IP?  

Resolution 

Before you try to install the Micro Filter for TCP/IP on a PC, make sure that you have the 
following:  

• DARGAL Version 59.070 or higher  

• Winsock TCP/IP on the PC  

• Unisys TCP/IP on the host  

To set up the Micro Filter for TCP/IP on the host, name the micro host in DARGAL. There is a 

setupfile entry named MICROHOST. You need to name the micro host or IP address in your 
setupfile, with the DARGAL Name command, or in a user profile.  

To set up the Micro Filter for TCP/IP on the host, you also need to specify your port number in 
EZINSTALL. Follow these steps:  

1. Choose SETTINGS on the EZINSTALL Main Screen. 

 

The Settings Menu Screen appears. 

2. Choose MICRO FILTER FOR TCP/IP on this screen. 
 

The Micro Filter for TCP/IP Screen appears. 

3. Enter your port number on this screen. 

 

Make sure that the port number you specify in EZINSTALL matches the port number 
you specify in the Micro Filter for TCP/IP installation program.  

 

Question 

When I try to copy a file using the Micro Filter for TCP/IP, I get the message "DARGAL MICRO 

CODE NOT FOUND." It works fine on another station. What could be wrong?  

Resolution 

Make sure that you have the necessary hardware and software and that you have specified all 

settings. See Running the Micro Filter for TCP/IP for details. In this case, the session that 



 
was working properly invoked a setupfile that contained the MICROHOST entry. The session 
that did not work invoked a setupfile that did not contain a MICROHOST entry. The micro 
host or IP address were not specified anywhere.  

 

Question 

I have installed the Micro Filter for TCP/IP on my PC and on several other users' PCs. 

Whenever the other users first try to use the Micro Filter, I get the message saying that they 

want to use my PC as the host. Why is this happening?  

Resolution 

The other users must be using your IP address as the micro host. When you install the Micro 

Filter for TCP/IP, name the user's micro host in DARGAL and specify the port number in 

EZINSTALL. There is a setupfile entry named MICROHOST. You need to name the micro host 

or IP address in each user's setupfile, with the DARGAL Name command, or in a user profile. 

You can specify the port number on the Micro Filter for TCP/IP Screen in EZINSTALL. (If you 

change the port number in EZINSTALL, you must also change it in the Micro Filter installation 
program.)  

 

Question 

How do I get rid of the Micro Filter for TCP/IP dialog box that appears asking if it is okay to 

use the PC as the host? It interferes with batch jobs.  

Resolution 

A Notify check box is available in the Access Rights dialog box in the Micro Filter window. 

If you are using the Micro Filter for TCP/IP, you can send output to a micro host. When you 

send the output, the Micro Filter for TCP/IP dialog box appears asking if it is okay to use 
the PC as the host. If you do not want this message to appear (as when running a batch job), 

remove the check beside Notify. Access is allowed or denied based on the settings for access 

rights. 

 

Specifically, take the following steps on the micro host to prevent the dialog box from 

appearing: 

• Bring up the Micro Filter for TCP/IP. 

• Choose the Access Rights command (Options menu) in the Micro Filter for TCP/IP 
window. 



 

• Remove the check beside Notify in the Access Rights dialog box and choose OK. 

 

(Access is allowed or denied based on the settings you made for Write and/or Print.)  

 

Question 

How do I connect to the Micro Filter for TCP/IP and URSA through VPN?  

Resolution 

1. Connect to your ISP by dialing up, using a DSL connection, or using a cable 

connection.  

2. Use VPN to get to your company network. (The A Series must be on that network.)  

3. Right-click on the VPN Connection icon (either on the taskbar or within Network and 

Dial-up Connections (Windows 2000) or Network Connections (Windows XP)).  

4. Select Status from the pop-up context menu.  

5. Select the Details tab and note the client IP address.  

6. Execute URSA and select the Preferences command (Options menu).  

7. In the Ursa Preferences dialog box, select the option button labeled Send this IP 

address or DNS computer name. Enter the client IP address from step 5 in the text 

box.  
8. To test, send report output to the Browse window.  

A Micro Filter for TCP/IP dialog box appears. It asks for your permission to send output 
to the Browse window.  

9. Choose Yes.  

You can work as usual in URSA.  

 
Copy related 
 

Question 

Can I copy a file from my micro to a micro that does not have the Micro Filter for Windows 

installed on it?  

Resolution 

You can copy a file to a micro that does not have the Micro Filter for Windows installed on it as 
long as it is logged onto the A Series and is in CANDE receive mode.  

 



 

Question 

When I tried to upload a file from a micro disk to the mainframe, I got the 100% transferred 

message almost immediately (and nothing was copied). What do I need to do?  

Resolution 

The file you are trying to upload does not contain any end of line (EOL) or carriage return (CR) 

characters. It may not have an end of file (EOF) character either. Import the contents of the 

micro disk file into a micro software product that allows you to save the file as a text (.txt) 

file. Once you save the file, the software inserts the necessary characters into the file. Then, 

upload the file (in its new format) to the mainframe.  

 

Question 

Can we perform several different downloads using the Copy utility at the same time from the 

mainframe to several workstations?  

Resolution 

As long as the Micro Filter for Windows is installed on each of the workstations, you can 
download data simultaneously to different workstations.  

 
Printing related 

 

Question 

How do I change printing orientation from portrait to landscape for just one report going to 

the microprinter?  

Resolution 

Specify printing orientation in the Micro Filter window.  

1. Bring up the Micro Filter window by clicking on the DARGAL icon (three nested 

probability curves).  

2. Choose the Printer Setup command (File menu).  

3. In the Orientation section of the Print Setup dialog box, choose Landscape.  
4. Choose the OK button.  



 
The settings you specify in the Micro Filter window are in effect for your current session only. 

If you want to specify Landscape for just one report, change the setting back to Portrait 
after your report prints.  

 

Question 

How do I specify a different microprinter for my reports that use the Micro Filter for Windows?  

Resolution 

Specify a different printer in the Micro Filter window.  

1. Bring up the Micro Filter window by clicking on the DARGAL icon (three nested 

probability curves).  

2. Choose the Printer Setup command (File menu).  

3. In the Print Setup dialog box, use the Name drop-down list to select a different 

printer.  
4. Choose the OK button.  

The settings you specify in the Micro Filter window are in effect for your current session only. 

If you want to specify a different printer for just one report, change the setting back to the 
original printer after your report prints.  

 

Question 

I don't like the way my reports look on the microprinter. Can I change the font, size, etc?  

Resolution 

Specify fonts in the Micro Filter window.  

1. Bring up the Micro Filter window by clicking on the DARGAL icon (three nested 

probability curves).  

2. Choose the Microprinter Fonts command (Options menu).  

3. In the Font dialog box, specify a font, font style, or size.  
4. Choose OK.  

The settings you specify in the Micro Filter window are in effect for your current session only.  

 
 

 



 

 
 

 


